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Ch. 1   Installation

Overview

Thank you for selecting CN!Express for your credit-card processing
needs.  This version of CN!Express connects you directly w ith your credit
card processor.  This direct connection increases the efficiency w ith which
your transactions are processed, thus reducing your processing fees.
CN!Express  is PS 2000 compliant when used in conjunction w ith an
approved credit card processor.  

This guide provides directions for installation as well as instructions for
performing most CN!Express functions.

System Requirements

Minimum required:
· WindowsÔ 3.11, Windows 95, Windows NT 3.51, or Windows NT 4.0
· 8 MB RAM  (at least 16 MB RAM for NT or 95)
· 16 MB free space on your hard disk (more if planning to have

transactions)
· External US Robotics Sportster w ith hardware handshaking serial cable,

if you use an enternal modem.

Recommended:
100 MHz Pentium
16 MB  RAM  (32 MB for NT or 95)
Uninterruptable power supply (UPS)

A Word About Modems

CN!Express has built-in support for the US Robotics Sportster modem.
Appropriate Solutions, Inc. (ASI), and many merchant processors,
recommend using an external Sportster for reliability and convenience.

The Sportster modem is fully certified for use w ith CN!Express.  Many
credit card processors strongly recommend that CN!Express customers
use a US Robotics Sportster modem.  This ensures the quality and
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Installation

integrity of your credit card processing link.  ASI works closely w ith your
credit card processor to ensure the modem can be set up and operated
quickly and easily.  Remember, it is your time and money moving
through that phone line.

You also need a serial cable that supports hardware handshaking between
your modem and your computer.  Most cables which ship w ith modern
modems support hardware handshaking, but you should always specify
this when you order.

A Word About Phone Lines

High-quality connections require clean, clear telephone connections.
Much depends on the quality of the connection from your computer to
your local telephone switching station.  Taking a few simple precautions
at your site helps to ensure your data arrives safely every time.

· Use a high-quality modem (which is why we support the US
Robotics Sportster).

· If possible, do not place your modem call through a PBX.  Use a
direct outside line.

· Listen on your phone line.  Can you hear other conversations or
echoes?  This is called cross-talk and can cause problems with your
data transfers.

· Use the shortest possible telephone cable from your modem to
your wall jack.

Install the CN!Express Software

1. Place the Installation disk, “ Disk 1 of 2”   in diskette drive A:.

2. For customers w ith Windows 3.11 or NT 3.51: from the Windows
Program Manager, select the Run command on the File Menu.

For customers w ith Windows 95 or NT 4.0: select the Run command
from the Start Menu.

3. Type A:\ Setup as the command line.

4. Click on the OK button.  The Welcome screen appears.

5. Click on Next.  The Choose Destination screen appears.
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Select a directory to which the setup program can copy the
CN!Express fi les.  We recommend you use the default directory
(C:\ CNX_SU) shown on the screen.

Note:  do not place CN!Express in the same directory w ith CN!Express
AutoProcessor or demo versions of the software.

6. Click on Next when ready.  The Ready to Install screen appears.
Verify the directory and click on Next. 

7. The Setup program copies several files to the hard disk and installs a
new icon in your Program Manager or Programs list.

8. The CN!Express Registration screen appears.  Enter your CN!Express
serial number from the label on the inside of this document.  Enter the
other information if desired.  Click on OK.  (Note: there is no
Registration screen in the demo version of the software.)

9. Click on Close when the Finished screen appears.

10. That�s it!  CN!Express is installed on your computer.  The next step is
to set it up for your particular needs.
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Ch. 2   Getting Started

This chapter assumes you have installed CN!Express.  

Note:  if you are running the demo software, you can skip this chapter.
The demo software comes pre-configured for you.  If you are running the
demo software, go to the next section, Chapter 3: Examples.

Overview

The configuration process is a simple process through which you enter all
the information particular to your company.

Before you begin, make sure you have all the required numbers from
your credit card processor.  Examples are: merchant number, client
number, terminal number.  These numbers help your credit card
processor identify data coming from your company.  

Required numbers:

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

Registration
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Getting Started Getting Started

Please take a few minutes to fil l out and return your registration form in
order to activate your customer support.
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Getting Started Run CN!Express 

Step 1 - Run CN!Express

1.  From Windows 3.11 or Windows NT 3.51, start the application by
double-clicking the CN!Express icon in the Program Manager.

From Windows 95 or NT 4.0, start the application from the Start
button (Start-Programs - CN!Express -  CN!Express ).

The Set Up CN!Express screen appears.  

This screen is a checklist that leads you through the required
configuration steps.
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Getting Started Enter Merchant Number 

Step 2 - Enter Merchant Number

A Merchant Number identifies the company actually receiving money
from transactions. Your credit card processor assigns the merchant
number.   

If you provide a service where you enter orders for more than one
company, you w ill need a separate Merchant Number for each company. 

1. Click on the Do Now button next to “ Enter a merchant number”  on the
Set Up Screen.  The Set Merchant Numbers screen appears.

2. Enter the Merchant Numbers and Descriptions as assigned by your
credit card processor.  Click on Add to enter them.  

To mark a Merchant Number as the default (added to each transaction
automatically), highlight it, then click on Default.  An asterisk appears
next to your selection.
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3. Click Done to return to the Set Up screen.  Notice that the first task is
checked off for you.



Getting Started Enter Client and Terminal Info 

Step 3 - Enter Client and Terminal Information

If you are running multiple copies of CN!Express they must all have
unique Terminal Numbers.  Your credit card processor assigns these.

1. Click on the Do Now button next to “ Enter client and terminal
numbers”  on the Set Up screen.  The Set Terminal Info screen appears.

2. Enter the Client Number and Terminal Number as supplied by your
credit card processor.  Enter all the digits provided.  For example, if
your credit card processor gives you a Terminal  ID of “ 001” , do not
enter just “ 1” .  Enter the full “ 001” or your transactions may fail.

3.  Click OK to return to the Set Up screen.  
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Getting Started Enter Phone Number 

Step 4 - Enter Phone Number

CN!Express needs to know information about your modem in order to
communicate w ith your credit card processor’s computer. 

Your modem is connected to the computer via a communication port.
There are usually two: COM1 and COM2.  COM1 is usually a small
connector plug and COM2 is usually a big connector plug on the back of
your computer.  If your mouse is plugged into a serial port,  it is usually
in COM1.  COM3 and COM4, if they exist, are usually internal  modems.

ASI strongly recommends the use of an external  modem on either COM1
or COM2.  Most external  modems plug into COM2, the big connector
plug.  Check your computer/ modem setup to verify.  (Remember to
specify a cable with hardware handshaking.)

1. Click on the Do Now button next to “ Enter Modem Information”  on
the Set Up screen.  The Communications Setup screen appears.  

2. Enter information as follows:

Phone Number is the phone number of the computer you are call ing.

We recommend you not call out through a PBX.  However, if you
must, you w ill probably need to add the two characters:
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9,
as the first two characters of the phone number.  The “ 9” asks for an
outside line and the comma (,) tells the modem to pause for two
seconds (for a dial tone) before continuing to dial the rest of the
number.

Modem.   You should be using a US Robotics Sportster modem.  

3. Verify that the other fields are set as follows.  Modify them if needed.
Rate: 2400
Parity: Even
Data Bits: 7
Stop Bits: 1
Port: the communications port to which your modem is 

attached.

4. Click OK on the Communications Setup screen.  You return to the Set
Up screen.

You have completed the Configuration.  Click OK to go to the
CN!Express Main screen.
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Step 5 - Testing and Training

Modem Test

In the modem test you test the hardware connections between your
computer and your credit card processor’s computer.  Your computer
dials your credit card processor’s computer and tries to connect.  No data
transfer takes place.  This is a quick “ sanity” check to make sure the
hardware is talking.

1. Select Communications on the Configure Menu.  The
Communications Setup screen appears.  

2. Click on Test Connection to see if your modem configuration operates
properly.  A Test Connection box appears and CN!Express attempts to
connect to your credit card processor’s computer.  Messages at the
bottom of the box  show  how the communication between the
computer and your modem is progressing.

3. When the test has successfully completed, click OK to return to the
Communications Setup screen.  That completes your modem test.  If
you are unable to complete the test successfully, contact ASI tech
support at (603) 924-6079.

4. Click OK again on the Communications Setup screen.  That’s it.  You
are ready for testing w ith the demo version.

Train Within the Demo Software

We recommend you spend some time training w ithin the demo version
of CN!Express.

The demo version is a separate application and is always available from
ASI’s web site: www.AppropriateSolutions.com.  
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You can try all the functions of CN!Express  w ithout worrying about
making mistakes w ith real transactions. The demo simulates the upload
and download of information from your credit card processor.  A ll other
processing is exactly the same as the “ live” version. 



Ch. 3   Examples

This section contains three examples to try on your own:
• Enter a transaction and submit it to a credit card processor 
• Change the Active Transactions list display
• Create a report

You can either work through these examples using the demo version of
CN!Express or the live version.  The steps are identical in both versions,
but the live responses w ill differ.  If you use the live version, remember
you are actually attempting to authorize and deposit real credit card
numbers.

Example:  Enter a transaction and submit it 

1.  From Windows 3.11 or Windows NT 3.51, start the application by
double-clicking the CN!Express Demo icon in the Program Manager.

From Windows 95 or NT 4.0, start the application from the Start
button (Start-Programs - CN!Express Demo - CN!Express Demo).
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The CN!Express Title screen appears, then the Main screen.  
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2. The cursor starts in the Credit Card data entry card at the bottom of
the screen.  Assume you are entering a credit sale for $100.  Enter the
following in the fields:

Number 5146 2875 6778 3904
Exp 9/ 99
Amount 100

CN!Express uses the default values in the Action and Merchant
Number fields.  Bill Zip is optional.
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Enter/ Submit Transaction  Examples

3. Press Enter to save the transaction.  The transaction appears on the
Active Transactions list on the upper part of the screen.

4. Click on the green dollar icon at the top of the screen.  This submits all
flagged transactions to your credit card processor.  CN!Express calls
your credit card processor, submits the transaction, and receives the
response.  (If you are working in the demo version, the
communication w ith your credit card processor is simulated.)  A
message window appears and updates you on the progress of your
submission.
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After making a connection to your credit card processor, CN!Express
transmits the data and retrieves a response.  A  progress bar shows
you that the transaction is being processed.

When the submission is complete, CN!Express displays a message
window:

5. Click OK.  CN!Express moves the deposited transaction to the
Completed Transactions list.  Click on the Completed Transactions tab
to see that l ist.
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That’s it.  You have successfully entered and submitted a transaction.
Refer to Chapter 4: Managing Transactions for more information.
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Example:  Change the Active Transactions list display

1. Click on the Active Transactions tab to display that l ist.  Enter several
transactions w ith differing actions and amounts.  Here are some test
credit card numbers you can use:

5146 2875 6778 3904
5243 7590 6905 2105
4267 9904 6753 2729
3711 9249 4413 723

2. Click on the Amount column title on the Active Transactions list.  The
list sorts by amount.  Note the up arrow  point next to Amount.
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Examples Change List 

3. Hold down Shift and click on the Amount column title again.  The
sort changes to a descending sort (high to low).  Note the arrow  point
also changes direction.

4. Click on the Action column title.  The list is resorted by Action, in
ascending order.
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5. From the Configure menu, choose Table Layout.  This allows you to
add and remove columns from the Transaction list.  The Set Column
Order screen appears:

6. Click on Card Type to highlight it.  Click on Add.  Card Type is added
to the Columns to Show  list.
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7. Click OK.  The Active Transactions list appears again, this time with a
new column “ Card Type” added to the end.

There are several other display options available.  Refer to the
Displaying Transactions section for more information.
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Example:  Create a report

1.  From the File menu, choose Report.  The CN!Express Reports screen
appears. 

2. Click on Preview to review the report on the screen.  A  progress bar
displays while the report is being generated, then the report displays
on the screen.

Click on the maximize button at the top of the screen to see the full
screen report.



Create Report  Examples

Full screen report:

4. Click on the exit button along the top row of the screen.  You return to
the Main screen.  Refer to the Reports section for information about all
the other report options.



                                                                                                              

Ch. 4   Managing Transactions

Overview

CN!Express is easy to use. It connects you directly w ith your credit card
processor.  The direct connection and easy-to-use data entry screens
simplify and speed up your credit card processing.  The basic process
flow is:

1. You enter customer credit card and purchase card transactions.  You
can enter them one at a time, or import them from a text fi le.  These
transactions appear on the Active Transaction list.

2. On a schedule you determine, you submit transactions to your credit
card processor.  You can submit as few  or as many as desired.

3. CN!Express connects w ith your credit card processor’s computer and
uploads the transactions, one at a time, receiving a response for each
one.

4. CN!Express merges the responses back into its internal database.
5. Transactions declined by your credit card processor remain on the

Active Transactions list for further work, as do successful
authorizations.  Transactions which are successful and need no
further action are moved to the Completed Transactions list.

This section contains instructions for the common tasks you may need to
complete. 
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Overview Managing Transactions

On the Main screen you can quickly switch between displays of work in
progress (Active Transactions) and completed work (Completed
Transactions).  You can also quickly switch between the data entry cards
for credit cards and purchase cards.  A ll your work is done from the Main
Screen, w ith pulldown menu commands and on-screen buttons to speed
you along.

Here is a sample Main screen:

4-2 CN!Express 
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Kinds of Transactions

CN!Express can process transactions from credit cards and purchase
cards.  Purchase cards require more data than do credit cards.  One click
on the Credit or Purchase buttons switches you between the data entry
“ cards” for the different sources.

Below are the data entry cards for credit card and purchase card
transactions.  They are located at the bottom of the Main Screen and
display the typically required fields.  You can see additional  fields by
clicking on the Addresses and Supplemental  tabs.

Credit Cards:

CN!Express 4-3



Kinds Managing Transactions

Purchase Cards:
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Managing Transactions Enter Transactions 

Enter Transactions

To enter a new transaction:

1. Display the Active Transactions list.  A blank (except for default
values) Main data entry card  displays at the bottom of the screen.  If
the Main data entry card is not blank, choose New from the
Transaction menu.  

  
2. Select the data entry card for the kind of transaction you w ish to enter

by clicking the Credit or Purchase button.

3. Enter the transaction information into the fields.  Use the Tab key to
move from field to field.  The minimum required information is:

Number
Expiration Date
Amount
Merchant Number
Action
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Verify the displayed default Merchant Number is correct.  If it is not,
click on the down arrow next to the Merc. Num. box to select a
different one.

4. Choose an Action.  Action is an important field.  It tells your credit
card processor what to do w ith each submitted transaction.

Authorize: Validate the card.
Credit Sale: Validate the card and capture the money in the

merchant’s account for deposit.
Partial Reversal: VISA  only.  A  reduction to the amount of a

previously authorized transaction.
Deposit: Deposit money in merchant’s account.

Transaction must already be authorized, or you
can obtain a voice authorization code.  The Auth
Code field appears when you choose Deposit as
the Action.

Refund: Refund money to the card.  Remove money from
merchant’s account.

Void: Void the transaction.  Must be done the same day
the transaction was entered.

5. If you need to fil l in address information, click on the Addresses tab
just above the data entry cards.  The Addresses card displays.  You
can also display this card by pushing F3 on the keyboard. 

Note: Refer to the Appendices for detailed information on any of the
fields on the data entry cards.
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There are two kinds of addresses:  Bil l and Ship.  Click on the
corresponding button on the left of the screen, then enter the address
information.  
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6. If you need to enter other information like tax and notes, click on the
Supplemental tab.  The Supplemental card displays.  You can also
display this card by pressing F4 on the keyboard.

Enter the desired information.  A ll these fields are optional as far as
CN!Express is concerned.  

7. Once you have entered all the information your company requires, the
next step is to save the transaction.  There are several ways to do this.
You can press Enter, click on the picture of the disk at the bottom of
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the screen, press Ctrl-S, or pull down the Transaction Menu and
choose Save.  Do whichever works best for you.

Note:  you can submit authorizations or credit sales immediately if
you w ish.  Instead of saving the transaction as above, click on the
Now! button at the bottom of the screen.  It saves your transaction and
submits it to your credit card processor in one step.  If you are
entering more than one transaction, however, it is more efficient to
save them all and submit them together as described in the next
section.

8. CN!Express verifies that all required information has been entered,
then clears the data entry cards for the next transaction.  (CN!Express
will prompt you for any missing information.)  It adds your
transaction to the Active Transactions list.  The flag indicates the
transaction has not yet been submitted to your credit card processor.

Additional Information
You can move between the data entry cards using the function keys F2
for Main, F3 for Addresses, and F4 for Supplemental.

Address verification is done automatically for all US addresses.  The
response is displayed on the Full Response Info card (F5).



Enter Transactions Managing Transactions

Reset (“ X” button
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  at the bottom of the screen) clears all the data entry cards and resets
fields to their last saved state.



Enter Transactions Managing Transactions



Managing Transactions Submit Transactions 

Submit Transactions to Your Credit Card Processor

Submitting transactions is the process of sending transactions to your
credit card processor and receiving responses.

Flags

CN!Express uses “ flags” to indicate which transactions are ready to be
submitted to your credit card processor.  

Transactions are automatically flagged as you enter them.  You can turn
flags on and off for individual transactions.  The Flag sub-menu on the
Transaction menu offers several choices.  You can:

· flag/ unflag the selected (highlighted) transaction
· flag/ unflag all the transactions currently displayed
· flag/ unflag ALL the active transactions

You can also flag/ unflag the selected transaction using the flag and
unflag icons on the menu bar.
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Submit

To submit transactions to your credit card processor:

1. Verify the flags are set for all the transactions to be submitted.  

2. Click on the Submit icon (the $ sign) on the menu bar, or choose
Submit Flagged on the Transaction menu.  A message window
appears and updates you on the progress of your submission.

After making a connection to your credit card processor, CN!Express
transmits the data and retrieves a response.  A  progress bar shows
you that the transactions are being processed.

3. When the submission is complete, CN!Express displays a message
window  with a summary of the results.  If any transactions are
declined, this window displays that information as well.
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4. Click on OK.  The processed transactions are moved from the Active
Transactions list to the Completed Transactions list.  To see them, click
on the Completed Transactions tab.  
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5. To see the response back from your credit card processor for a
transaction, highlight it on the Completed Transactions list and press
the Full Response Info tab on the lower part of the screen.

Note:  you can also include any of this information on the Completed
Transactions list by changing the table layout.  See Chapter 5:
Displaying Transactions.
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Deposit Authorized Transactions

Sometimes you may have authorized orders that need to be deposited.
An example of this is a backorder situation where you want to verify the
card but not charge the customer until the product ships.  The orders w ill
initially be submitted to your credit card processor as Action “ Authorize.”
At some later time you w ill need to deposit these authorized orders.  

Note:  you can also create a deposit transaction from scratch as long as
you have an authorization code, usually from a voice authorization.

To deposit an authorized transaction:

1. On the Active Transactions list, flag the authorized transactions you
want to deposit.  Make sure the Action is set to Deposit for each one.  

2. Click on the Submit Flagged icon (green $) on the menu bar. A
message window appears and updates you on the progress of your
submission.  When the submission is complete this w indow  displays:
  

3. Click the OK button.  The transactions move from the Active
Transactions list to the Completed Transaction list.
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Process Declines

After processing each transaction, your credit card processor sends a
response back to CN!Express.  Transactions are either approved or
declined.  Declined transactions remain unflagged on the Active
Transactions List w ith a new status “ Failed.”   

To process declines:

1. H ighlight the declined transaction on the Active Transactions List.
Click on the Full Response Info tab above the data entry cards.  The
Full Response Info card displays the information returned by your
credit card processor.

2. Do what is necessary to fix the problem.  There are many reasons your
credit card processor may decline a transaction (authorization
declined, lost/ stolen card, invalid card number, etc.).  Frequently you
will be requested to call the credit card processor for a voice
authorization. 

Note:  sometimes a declined transaction cannot be fixed due to, for
example, a stolen card.
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When the problem is fixed, re-flag the transaction by clicking on the
flag icon at the top of the screen.  The transaction is now ready for
re-submission to your credit card processor.
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Refunds

A refund is a transaction that returns money to the customer’s card and
removes the money from the merchant’s account.  There are two ways to
generate a refund.

METHOD 1: create a refund from a Credit Sale or Deposit on the
Completed Transaction list:

1. H ighlight the transaction to be refunded on the Completed
Transactions list.

2. From the Transaction menu, choose Make Refund from Selected.  A
confirmation w indow appears.

3. Click Yes.  A Refund transaction appears on the Active Transactions
list.  It is unflagged.  Remember to flag it when you are ready to
submit it.

METHOD 2: enter a new Refund transaction:

1. From the Transaction menu, choose New.  A  blank Main data entry
card displays at the bottom of the screen.  

2. Select the data entry card for the kind of transaction you w ish to enter
(credit or purchase card).

3. Enter the transaction information.  Choose Refund as the Action.  

4. Press Enter.  The Refund appears on the Active Transactions list,
flagged, and ready for submission.



Refunds Managing Transactions



Managing Transactions Partial Reversals 

Partial Reversals (VISA only)

A Partial Reversal is a transaction applicable only to VISA cards.  A
Partial Reversal allows you to reduce the amount of a previously
authorized transaction, w ithout having to issue a refund. 

For example, suppose a customer orders three plates at $20 each, for a
total of $60.  You submit and receive an authorization for $60.  But, you
only have two plates in stock.  Therefore you need to reduce the charge to
the customer from $60 to $40.  You submit a Partial Reversal for the new
total amount of $40.  The new authorization replaces the old one.  The
customer is charged $40 when you deposit the transaction.

Note:  CN!Express does not prevent you from submitting partial reversals
for cards other than VISA cards.  However, your credit card processor
will decline them.

To perform a partial reversal:

1. H ighlight the authorized VISA  transaction that needs a partial
reversal.  From the Transaction menu, choose Adjust Authorized
Amount for Selected.  The Set New Authorization Amount screen
appears.

2. Enter the new  total value (not the dollar amount to reverse).  Click
OK.

3. The Action is updated to Partial Reversal.  Press Enter.  A
confirmation message appears.
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4. Click Yes.  The transaction is ready for submittal to your credit card
processor.  You will receive a new authorization code when you
successfully submit it.
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Void, Close, or Delete Transactions

Void, Close and Delete perform very different functions in CN!Express.  

Void is a transaction — like Credit Sale or Refund.  A void transaction is
handled like any other, moving to the Completed Transaction list once it
is processed.  The rules for a void are:

· The transaction to be voided must appear on the Completed
Transactions list w ith a status of Deposited or Refunded.

· You must submit the void transaction the same day as the
original transaction, i.e. while the original batch is sti ll  open.

Close moves the transaction immediately from the Active Transactions
list to the Completed Transactions list.

Delete permanent ly removes an active transaction from the CN!Express
database.  There is no way to undo a delete, so be sure before you do one!
You can delete any kind of transaction on the Active Transactions list. 

Note:  Void does alter the information held by your credit card processor.
Close and Delete alter data only in CN!Express.  They do not send a
transaction to your credit card processor.

Why would you choose Close versus Delete?  Close lets you keep a
record of what you did.  Once the transaction is on the Completed
Transactions list it can be archived normally.  Delete makes transactions
disappear — no record anywhere.

Void

To send a void transaction to your credit card processor:

1. H ighlight the transaction to void on the Completed Transaction list.  It
must have a status of Refunded or Deposited.



Void, Close or Delete Managing Transactions

2. From the Transaction menu, choose Void Selected.  A  Confirmation
window  appears:

3. Click on Yes.  CN!Express displays the new void transaction on the
Active Transactions list.

4. Flag the transaction so it w il l be submitted w ith the next call to your
credit card processor.  You must submi t the void the same day as the
original  transaction.
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Close

To close a transaction and move it immediately to the Completed
Transactions list:

1. H ighlight the transaction to be closed on the Active Transaction card.

2. From the Transaction menu, choose Close.  A Confirmation w indow
appears:

3. Click Yes.  The transaction is moved to the Completed Transactions
list w ith a status of Closed.  
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Delete 

Delete permanently removes an active transaction from the CN!Express
database.  You cannot delete transactions from the Completed
Transactions list.  Use Archive to remove completed transactions from
CN!Express .

To delete an active transaction:
 
1. H ighlight the transaction to be deleted on the Active Transaction card.

2. From the Transaction menu, choose Delete.  A  Confirmation w indow
appears:
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3. Click Yes to remove the transaction from the Active Transactions list.  
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Get Information about a Batch

Your credit card processor assigns a Batch ID to all transactions
submitted during a particular period of time, usually a 24 hour period
beginning in the early morning.  This information is part of the response
for each submitted transaction.  You can see the Batch number for a
transaction on the Full Response Info card.  

While a batch is open you can ask your credit card processor about the
status of the batch, what is in it, etc.  To do so:

1. H ighlight a transaction from the batch you w ish to query.  The batch
must sti ll  be open. 

2. From the Transaction menu, choose Query Batch.  The Enter Batch to
Query screen appears w ith the necessary information already fi lled in.

3. Click OK.  CN!Express calls your credit card processor and requests
information about the batch.  
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When the Query is complete, the Query Complete screen displays:

4. Click OK.  That’s it.
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Close a Batch

There are two ways to close a batch.  

1. You can choose an automatic close, usually offered early in the
morning.  This needs to be set up w ith your credit card processor.

2. You can close the batch manually, any time of the day.

To manually close a batch:

1. From the Transaction menu, choose Close Batch.  The Enter Batch to
Close screen appears w ith the necessary information already fil led in.

3. Click OK.  CN!Express calls your credit card processor and requests
the batch be closed.  When the closing process completes, a
completion message displays:

4. Click Yes to see the Query Batch information.  Otherwise Click No.
That’s it.
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Ch. 5    Displaying Transactions 

CN!Express provides several ways to look at the information on the
Active and Completed Transactions lists.  You can:

· Select the columns to show on the list.   
· Display all the transactions in the database, or just the current

day’s, or according to custom fi lter criteria you set up.
· Sort the list by any field in ascending or descending order.

By default, all transactions are displayed and are sorted in ascending
order by LastModified date.

Scrolling Through the List

Once a transaction list is more than one screen long, scroll bars appear on
the right side of the list.  The top button (see circled buttons) moves you
to the top of the list.  The middle button moves you up one screen’s
worth.  The lower button moves you up one line.  The set of three buttons
at the bottom of the scroll bar work in a similar fashion.   

CN!Express 5-1



Scrolling Displaying Transactions

5-2 CN!Express 



CN!Express 5-3



Change Columns Displaying Transactions

Change the Columns on the List

You can change the columns displayed on the Active and Completed
Transactions lists.  A ll fields in CN!Express are available to use as
columns.

Note: CN!Express remembers an existing sort as long as the sorted
column is stil l  displayed.  If you remove a column that is being used for
the sort, you w ill see the default unsorted list order.  

To change the columns:

1. From the Configure menu, choose Table Layout.  The Set Column
Order screen appears:

2. There are two main boxes on the screen:  Available Columns and
Columns to Show.

To remove a column from the transactions lists, highlight it in the
Columns to Show  box.  Click on Remove.  The column moves to the
Available Columns box.

To add a column to the list, highlight it in the Available Columns box.
Click on Add.  The column moves to the Columns to Show box.
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3. Use the Sequence buttons to arrange the order of columns in the
transaction list:

Top moves highlighted column to the top of the list
Up moves column up one spot 
Bottom moves column to the bottom of the list
Down moves column down one spot

4. When the columns are in the desired order, click OK.  CN!Express
displays the list w ith its new layout.
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Set Up a Filter

Setting up a filter allows you to see a specific subset of your data.  You
can choose transactions from a specific date, and/ or transactions w ith a
specific value in a field.  The fi lter applies to both the Active and
Completed Transactions lists.

Filtering is a two step process.  You define what the fi lter is, then turn it
on and off by toggling “ Filtered”  on the View menu.

To define a filter:

1. From the View Menu, choose Set Filter.  The Set Filter screen appears:

2. If you want to see records from a specific date, click on the By Date
box and enter the desired date.  

3. If you want to see records w ith, for example, a specific Status, click on
the By Field box.  Choose a field from the field box.  You may choose
between any of the columns currently displayed on the Transactions
lists.

Enter (or choose) a value for that field.

4. Click OK.  Your fi lter is set!
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Switch Between All, Today’s, or a Filtered Display 

You can show  all the transactions in the database, or just the current
day’s, or according to a custom fi lter you set up.

To change the display:

1. Pull down the View  menu.  Choose one of the following:
All Transactions
Today’s Activity
Filtered

2. Both the Active and Completed Transaction lists now show the new
display.  That’s it.
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Change the Sort

You can sort the Active and Completed Transactions lists in ascending
(smallest value to largest value) or descending order by any of the
columns displayed.  There are two ways to do a sort.  

METHOD 1:  Use a Click or a Shift-click to sort the displayed list.  

Click Toggles between unsorted and an ascending order sort.
Shift-click Toggles between unsorted and a descending order sort.

1. Click on the column title of the column you w ish to sort by (on this
example, Amount).  The list is sorted in ascending order by the values
in that column.  Note the up arrow in the column title.
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2. Press Shift-click on the same column title to sort in descending order.
The arrow switches to a down arrow.
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3. Press Shift-click again on the column title to return to the original
display.  The arrow disappears.
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METHOD 2.  Set up the sort on the sort screen:

1. From the View menu, choose Sort By.  The Set Sorting Order screen
appears:

2. Click on the Sort box for the list you w ish to sort.  This activates that
part of the screen.

3. Select a field from the Sort By pop-up box.  The field l ist displays.
H ighlight the field by which you w ish to sort.

4. By default the sort is in ascending order from smallest to biggest.  If
you want descending order, click on the descending box.

5. Click OK.  CN!Express sorts the list and displays the list in its new
order





Ch. 6   Reports

Checking summary reports is an important part of the CN!Express
process.  There are four reports available:

Current View: Transactions currently displayed on the
Active and/ or Completed Transactions
lists.

Daily Account Summary: A ll activity for a particular date.
Periodic Account Summary: A ll activity for a range of dates.
Batch Summary: A ll activity for a specific batch.

You can view a report on the screen or print it to a printer.  Each type of
report has different options.

To print a report:

1. From the File menu, choose Report.  The CN!Express Reports screen
displays.
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2. Choose the desired report by clicking on the button next to its name.
The options for each report are displayed on the right side of the
screen:

Current View:

Daily Account Summary:
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Periodic Account Summary: 

Batch Summary:
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3. Click on Preview to review the report on the screen.  You can review it
on the screen, or review it, then click Print to print it out.  This
example shows a Current View report for Active Transactions.

Note: Copy copies the report into your computer’s “ clipboard” , from
where you can paste it into another document.

A lternatively, click Print to print the report directly to a printer.  The
Print screen displays:

 

Choose your desired options and click on OK.  That’s it.
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Report Samples

Here is a sample of each report:

Current V iew



Report Samples Reports

Dai ly Account Summary



Reports Report Samples

Periodic Account Summary

Batch Summary
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Ch. 7   Import and Export Files

Overview

You can automatically load transaction data from another application
into CN!Express.  The fi le must be a delimited text fi le.  Prior to importing
you set up (or confirm) a template that tells CN!Express how to interpret
the data in the text fi le.  

Similarly, you can export data from CN!Express to other programs.
CN!Express creates a text file according to specifications you set up in an
export template.

 Note:  If you are running the demo software, default import and export
templates are already set for you.  You can modify them as desired.

What is a delimited text file?

Delimited text fi les are simple ASCII text files.  Each line in the text fi le is
a record from your database.  Each column or field in the record is
separated from the other fields in the record by either a tab, a comma, or
some other character.  This is the delimiter.  The files may have one,
several, or dozens of transactions.

How does CN!  Express   know the format for these import/export files?  

CN!Express uses templates to describe file formats.  There are separate
templates for import and export files.   Before defining an import
template you must have a sample file from which to build the template.

Where does CN!  Express     find import files?  

You must tell CN!Express where to look to find the text files to be
imported.  The directory can be on a remote machine or fi le server.
Import files must have the fi le extension .IMP or .TXT in order to be
recognized by CN!Express.  By default, CN!Express looks in the IMPORT
subdirectory under the directory into which you initially installed
CN!Express.  
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Import files could be generated by another application such as a point of
sale application, order entry, or just a simple database such as Microsoft
AccessÔ, Borland dBaseÔ, or M icosoft Excel Ô.  These applications don’t need
to be running on the same computer -- they don’t even need to be
Windows applications.  CN!Express can accept text files from
minicomputers or mainframes.  Any application capable of creating a
delimited text file can present credit card transactions to CN!Express.

What do all the different file extensions mean?

CN!Express uses file extensions to distinguish between several  types of
files.  Here are the important ones:

.txt Text file 

.imp Import file containing transactions to process

.exp Export fi le

.rej Reject file containing copies of records which could not 
be imported.  Probably improperly formatted.  

What happens to the import text file after it is imported?

Nothing.  It remains exactly as it was before the import.  

What is a reject file?

As part of the import process, CN!Express checks the fi le for records w ith
formatting errors or missing required information.  CN!Express rejects
these records.  CN!Express creates a reject file (extension .REJ) containing
the rejected records.  The rejection reason appears at the end of each
record.  

You can review reject files w ith any text editor or word processor.  Reject
files appear in the same directory as the original import fi le.

What happens to the data in CN!  Express   after it is exported?  

Nothing.  Export copies the transaction data to the export text file.  Your
data in CN!Express remains as it was.  The only way to remove
transactions from CN!Express is by using Delete or Archive.
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Deciphering Your Import Text File

Before configuring templates, let’s take a look at the sample import file,
SUIMPORT.TXT, and see what happens when you choose different
template options.

Below are the first few lines of the text file.  To make it easier to read in
this manual, we added a blank line between each record.  In reality, each
record is one line of a w ide text fi le.  The fields are delimited, or
separated, by commas.  Each field is enclosed by quotes.

" C" , " 5240- 1519- 1015- 1570" , " 11/ 99" , " 258. 98" , " Desk" , " Li nda" , " Pool e" , " 5089
Car ol  Lane" , " Pet er bor ough" , " NH" , " 03458" , " ( 603) 924- 8806"

" A" , " 4102153902028" , " 11/ 98" , " 87. 00" , " Pant s" , " Har r y" , " Br at t on" , " 345 Scot t s
Val l ey Rd" , " Car mel " , " CA" , " 93411" , " ( 415) 889- 0202"

" R" , " 371039098301012" , " 12/ 98" , " 104. 48" , " Tool s" , " Car l " , " Mal one" , " 1009
Thi r d Ave" , " Por t l and" , " OR" , " 97120" , " ( 503) 235- 8012"

" C" , " 5300- 3040- 00023- 574" , " 09/ 98" , " 78. 50" , " Boot s" , " Bet h" , " Sal azar " ,
" 6783 Topper  Ln" , " Por t l and" , " OR" , " 92512" , " ( 503) 773- 8291"

" C" , " 5300- 3040- 0002- 3574" , " 12/ 98" , " 165. 99" , " Shoes" , " Sal l y" , " Ket hcum" ,
" 10 Br adl ey Ct " , " Hancock" , " NH" , " 03449" , " ( 603) 525- 8124"

Here is how you want the text to appear on the Configure Import screen:

The data from your text file is displayed on the screen with  the correct
column titles.  The Fields box lists the CN!Express fields not being
imported or simply not in the text file.
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Your goal in configuring the import template is to tell CN!Express how to
correctly interpret an import fi le.  What you want to see on this screen is a
set of nice clean data w ith no extraneous information (no strange
characters, no quotes, no field names except in bold at the top of each
column).  That means your template is working correctly for the
displayed text file.

On the next few pages are examples of template options set correctly and
incorrectly for this sample text fi le.
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Here is the screen with the wrong delimiter chosen (tabs).  The data is all
crammed into one column because CN!Express does not know  how to
separate it.  CN!Express also cannot figure out any column titles -- “ not
used” means CN!Express w ill ignore this column during the import
process. 

Now here it is w ith the correct delimiter, commas, chosen:
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Here is the screen with the Fields Include Quotes option turned off
(incorrect).   The quotes appear in the columns.

Now here it is w ith the Fields Include Quotes option turned on (correct).
The quotes do not appear.  Remember, the goal is CLEAN data w ith no
extraneous characters.
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Here is the screen with the First Row Contains Field Names option
incorrectly turned on.  You lose the first l ine of the file (compare to
bottom of page).

Now here it is w ith the First Row  Contains Field Names option turned off
(correct).  The first line re-appears.
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Here is the screen with everything wrong!

And finally, here it is w ith everything correctly set.  Notice that only data
displays -- no quotes, no delimiters, no field names.  This is what you
want your template to look like.

Note:  your correct settings may differ from these.
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Here is another aspect.  These two screens compare importing a field
versus ignoring it.  The first screen shows the template set up to import
Action (first column).  Notice that Action is dimmed in the Defaults box
on the lower half of the screen.

Here is what it looks like when we decide to import files w ith one Action
type only, and apply a default Action.  Notice that Action is added to the
Fields box and that Action is no longer dimmed out in the Defaults box.
A ll the transactions w ill now be processed as Credit Sales, ignoring the
data in the import fi le.  We recommend setting a default Action only for
import files that lack an Action designation.
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Import

To import a fi le:

1. From the Main Menu, choose Import.  The Select Delimited File to
Import screen appears.
  

2. On the left of the screen is the list of Ò.txtÓ and “ .imp” fi les in the
open directory.  Move to the directory that contains your text fi le
(usually your Import directory).  H ighlight the desired text file and
click OK.  The Configure Import screen appears.
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3. The data from your text file displays on the screen with CN!ExpressÕs
best estimate of the correct column titles.  The Fields box lists the
CN!Express field names corresponding to the “not used”  columns, or
corresponding to data not in the text file at all.  The “ not used”  column
title means the data in that column will not be imported.

Set the options to give you a nice clean display.  Feel free to toggle
each option to see what the “ messy” version looks like.

4. Select the correct delimiter for your file (tabs or comma).  If this is set
incorrectly, your data w ill appear crammed in a single column.  

5. Click on the appropriate check boxes to turn on or off the indicators
for ÒFirst Row Contains Field NamesÓ (usually off)  and ÒFields
Include Quotes.Ó  You should not see field names or quotes in the
display (other than the bold column titles).  If either is there, the
setting is wrong.  Refer to the previous pages for examples of correct
and incorrect settings.

6. Review the file using the scroll bars.  The information in columns
titled Ònot usedÓ is not imported.  If there is other information you
do not want imported, click on the column title and drag it to the
Fields box.  It is added to the Fields box and Ònot usedÓ replaces it as
a column title.  You can drag titles back and forth from the Fields box
until everything is set up to your satisfaction. 

The Appendices define all the fields available.

7. When all is to your satisfaction, click on OK.  CN!Express imports the
data from the text fi le.  A  Status w indow shows you the progress of
the import.  
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A  summary message displays when the import is complete.  

8. Click OK.  That’s it.  The transactions are now included on your Active
Transactions list.
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Export

You can export data from CN!Express to other programs.  CN!Express
creates a text fi le according to the specifications you supply.  You might
be exporting it, for example, for use in a spreadsheet, or perhaps back to a
mainframe for further processing.

1. Display the Transaction List you w ish to export.  Use the options on
the View  menu to get the desired set of transactions.

2. From the File Menu, choose Export View.  The Export View As File
screen appears.
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3. Enter the name of your export file (Ò.txtÓ suffix), or choose one from
the list.  If you choose an existing filename you w ill be asked to
confirm that you w ish to replace the existing file.  Click OK.  The
Choose Fields to Export screen appears.

There are two main boxes on the screen:  Available Fields and Fields
to Export.  By default, a subset of fields is exported.

4. If you w ish to add any fields to the list, highlight the field in the
Available Fields box.  Click on Add.  The field moves back to the
Fields to Export box.

To remove fields from the export l ist, highlight the field you w ish
removed.  Click on Remove.  The field moves to the Available Fields
box.

5. Use the Sequence buttons to arrange the order of fields in each record
of the export file:

Top moves highlighted field to the top of the list
Up moves field up one spot 
Bottom moves field to the bottom of the list
Down moves field down one spot
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6. Select Add Field Names to First Record if you want the first line of the
export fi le to contain field names (to label the data).

7. Select Add Quotes if you want quotes around the data in each field
(e.g. Ò9/ 24/ 97Ó).

8. Select the delimiter required or desired by your destination program
(typically commas or tabs).

9. Click OK.  The export takes place.  A  message tells you how many
records were exported to which fi le.

Click OK.  YouÕre done!
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Ch. 8   Database Maintenance

Backups

Backup your CN!Express database regularly.  Most of the data is in the
DATA directory.  This contains the day to day transactions, etc.  Usually
you can backup the entire database structure as it is rather small.

Archive

The Archive function in CN!Express exports all completed transactions
before a certain date to one tab-delimited text fi le.  Everything in the
database related to those transactions is exported.  You are then free to
import the data into any other application that accepts text fi les.  The
column names are on the first l ine of the file.  

Note:  once archived, the data is gone from CN!Express.

To archive transactions:

1. From the Main menu, choose Archive.  The Archive Completed
Records screen appears.
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2. The Archive Date defaults to 30 days ago.  You can enter another date
if you w ish.  Click OK to start the archive process.

3. When the archive process is complete, a completion message displays.

4. Click OK.  That’s it.
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Pack

The Pack function cleans up your database and helps keep CN!Express
running at a good speed.  Every time a transaction moves from the Active
Transactions list to the Completed Transactions list, a hidden copy is left
behind.  Likewise, when you delete a transaction, it is marked for
deletion, but stil l  takes up space in the database.

Pack removes the copies and the marked-for-deletions, thus “ packing” the
database more efficiently.

We suggest you run Pack at the beginning of each month or at any time
you notice CN!Express running slower than usual.  Automatic packs
occur each time you export or archive.

To pack your CN!Express database:

1. From the File menu, choose Pack.

2. A  completion message displays when the packing completes.  Click
OK.  That’s it!

CN!Express 8-3



Pack Database Maintenance



Appendix A - Field Summary

Standard Card Types

The following two-character codes are returned by the processor to
indicate the type of credit cards being processed:

VI Visa
MC MasterCard
DS Discover
AX American Express
CB Carte Blanche
DC Diners Club
JC JCB

Fields

The following table provides a quick reference to all the CN!Express fields
available for import and export.  The last column provides either a data
import pattern (such as ####.## for monetary values) or the maximum
number of characters/ digits a particular field can consume.

Import and Export fields are not fixed length.  They are delimited by
either tabs or commas.  Therefore, a text field w ith a maximum size of 20
characters could have one, or in some cases even no, characters in the
field.

In CN!ExpressÊall fields are available for Exporting.  A ll fields can also be
imported although some fields are ignored. This behavior allows you to
define the same fi le layout for both import and export fi les.  The second
to last column indicates if the field is ignored in imports.

The TCSA column indicates if the field is found in Typical, Check,
Special, or A ll options setting.
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I mpor t
TCSA       Fi el d Name               Descr i pt i on                           I gnor ed      Pat t er n  
TCSA Account Type " Cr edi t Car d"  or  " Check" Y 10 char s
TCSA Act i on Si ngl e- char act er  Act i on I D 1 char
TCSA AmexCI D Amer i can Expr ess Car d I D 4 char s
TCSA Amount Tr ansact i on dol l ar  amount  ( US $) ######. ##
TCSA Aut hCode Appr oval  Code f r om Aut h Sour ce 6 char s
TCSA Aut hDat e Dat e on whi ch appr oval  occur r ed mm/ dd/ yy
SA Aut hNet I D Pr ocessor  Speci f i c Y 2 char s
SA Aut hSour ce Pr ocessor  Speci f i c Y 1 char
SA Aut hTi me Ti me at  whi ch appr oval  occur r ed hh: mm: ss
A Aut oPr ocessor I nt er nal  f i el d Y 1 char
TCSA AvsDet ai l Human- r eadabl e descr i pt i on of  32 char s

Addr ess Ver i f i cat i on Response
TCSA AvsResponseCode Addr ess Ver i f i cat i on Response 2 char s
A Bat chFl ags I nt er nal  f i el d Y 4 di gi t s
TCSA Bat chI D Ret ur ned f r om pr ocessor 10 di gi t s
TCSA Bi l l Addr ess1 St r eet  Addr ess t o whi ch car d bi l l ed 20 char s
SA Bi l l Addr ess2 Secondar y addr ess i nf o 20 char s
TCSA Bi l l Ci t y Car d hol der ' s ci t y 16 char s
SA Bi l l Count r y Car d hol der ' s count r y 10 char s
SA Bi l l Fi r st Name Car d hol der ' s f i r st  name 16 char s
SA Bi l l HomePhone Car d hol der ' s home phone number 24 char s
SA Bi l l Last Name Car d hol der ' s l ast  name 16 char s
TCSA Bi l l St at e Car d hol der ' s st at e 2 char s
SA Bi l l Wor kPhone Car d hol der ' s wor k phone number 24 char s
TCSA Bi l l Zi p Car d hol der ' s zi p 9 char s
TCSA Car dOr Account Cr edi t  car d or  Bank Account 24 char s
TCSA Car dType Type of  cr edi t  car d 2 char s
CSA CheckType 0:  Per sonal ,  1: Payr ol l ,  2: Gov 1 di gi t
CSA Cl er kI D I dent i f i er  f or  per son accept i ng 4 char s

check.
TCSA Cl i ent Number Pr ocessor - speci f i c cl i ent 4 di gi t s

i dent i f i er .
TCSA Cust omer Ref er ence PO or  Cust omer  number 17 char s

( Requi r ed f or  Pur chase Car ds)
TCSA Deposi t Dat e Dat e t r ansact i on deposi t ed Y mm/ dd/ yy
SA Deposi t Ti me Ti me t r ansact i on deposi t ed Y hh: mm: ss
TCSA Descr i pt i on1 Gener i c descr i pt i on f i el d 24 char s
SA Descr i pt i on2 Gener i c descr i pt i on f i el d 24 char s
SA Descr i pt i on3 Gener i c descr i pt i on f i el d 24 char s
SA Descr i pt i on4 Gener i c descr i pt i on f i el d 24 char s
SA EDS I nt er nal
A Encr ypt edPI N Fut ur e.  Debi t - car d speci f i c.
TCSA Expi r at i on Cr edi t  car d expi r at i on dat e mm/ yy
A Fi l eI D I nt er nal  f i el d Y
TCSA Host Response Pr ocessor - speci f i c er r or  code. Y 3 char s
SA I nt er changeSpec See not e bel ow 40 char s
A I sFi l eMember I nt er nal  f i el d Y
A I t emFl ags I nt er nal  f i el d Y
TCSA Last Act i onSucceeded “ 1”  i f  successf ul ,  “ 0”  i f  f ai l ur e 1 char
SA Last Modi f i ed Dat e on whi ch l ast  change t o 24 char s

( act i on on)  r ecor d occur r ed.
A MagSt r i pe Fut ur e.  Requi r es car d swi pe.
CSA Mer chAmount Mer chandi se $ Amount ######. ##
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( Check Aut h Onl y) .
TCSA Mer chant Number Pr ocessor - speci f i c Mer chant  I D 12 di gi t s
SA Net wor kResponse Net wor k- speci f i c er r or  code. Y 3 char s
TCSA Or der Number Or der  # f or  t r acki ng 16 char s

( Not e:  Gensar  suppor t s onl y 9 char s)
A Pi nCapCode Fut ur e.  Debi t - car d speci f i c
TCSA Pr ocessed I nt er nal Y
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I mpor t
TCSA       Fi el d Name               Descr i pt i on                           I gnor ed      Pat t er n  
SA Pur chaseType 1:  Si ngl e Pur chase Tr ansact i on 1 di gi t

2:  Recur r i ng Bi l l i ng Tr ansact i on
3:  I nst al l ment
4:  Unknown

TCSA ResponseDet ai l Readabl e Aut h/ Pr obl em message Y 32 char s
SA Ret r Ref er ence Tr acki ng # cr eat ed by pr ocessor Y 9 char s
A SequenceNumber I ncr ement ed t r ansact i on number Y 6 di gi t s
SA Shi pAddr ess1 Addr ess t o whi ch mer chandi se shi pped 20 char s
SA Shi pAddr ess2 Secondar y st r eet  addr ess 20 char s
SA Shi pCi t y Addr ess t o whi ch mer chandi se shi pped 16 char s
SA Shi pCount r y Addr ess t o whi ch mer chandi se shi pped 10 char s
SA Shi pFi r st Name Per son t o whom mer chandi se shi pped 16 char s
SA Shi pHomePhone Phone t o whi ch mer chandi se shi pped 24 char s
SA Shi pLast Name Per son t o whom mer chandi se shi pped 16 char s
TCSA Shi ppi ngHandl i ng Shi ppi ng/ Handl i ng cost s ######. ##
SA Shi pSt at e St at e addr ess t o whi ch mer chandi se 2 char s

shi pped.
SA Shi pWor kPhone Per son t o whom mer chandi se shi pped 24 char s
SA Shi pZi p Zi p t o whi ch mer chandi se shi pped 9 char s
SA Sof t Descr i pt or 1 Unused- - Fut ur e 16 char s
SA Sof t Descr i pt or 2 Unused- - Fut ur e 16 char s
A Sour ceRecor d I nt er nal
TCSA St at us Text ual  st at us r epr esent at i on 20 char s
TCSA Suppl i er Ref er ence Or der / I nvoi ce # 9 char s

( Requi r ed f or  Pur chase Car ds)
( Amer i can Expr ess onl y)

TCSA Tax Sal es Tax ######. ##
TCSA Ter mi nal Number Ter mi nal  I D ###
CSA Tr ansi t Num Bank number  f or  checks 9 char s

Account  i n Car dOr Account  f i el d)
A User Fut ur e.  Logi n I D of  Oper at or 12 char s
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Tables

InterchangeSpec
Certain processors (such as Visa and MasterCard) return what is known
as Interchange Specific information.  This information is decoded in
different formats depending on the specific service being used. 

If you are performing separate Authorization and Deposit actions (vs.
performing a single Credit Sale action), then submitting this information
with your Deposit transaction may qualify you for lower processing fees.
Contact your processor for specific details.

AvsResponse
The following table lists the Address Verification Service response codes
returned by the processor:

X Exact match on address and 9 digit ZIP code.
Y Exact match on address and ZIP code.
A Address matches. ZIP code does not match.
W 9-digit ZIP code matches. Address does not.
Z ZIP code matches. Address does not.
N Neither ZIP nor address matches.
U Unavailable. Address info unavailable or issuer does not support

AVS.
R Retry. Issuer�s system unavailable.
E Error. 
S Service not supported by issuer.
" " (Space) Service not performed.
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Appendix B - Basic Import Fields

Overview

CN!Express accepts import fi les which contain delimited data.  The two
most common delimiters are tabs and commas.  In addition, the data in
the fields may be surrounded by double quote characters.  Quoting the
field contents ensures that none of the characters in the field are
interpreted as a delimiter.  For example, the entry:

Smith, Jr.
is interpreted as two fields (if importing a comma-delimited file).
However, the entry:

"Smith, Jr."
is interpreted as a single field.

Appropriate Solutions recommends always using quoted fields with
either tab or comma delimited import files.  It simply reduces the
incidence of surprises. 

CN!Express does not force any particular field ordering in the import fi le.
The Import Template Design (accessible from Configure:Import) allows
the user to associate columns in the import text file w ith internal database
fields.  These templates are saved for later reuse. 

In addition to the fields listed in this document, users may have any
number of additional fields in the original import fi le which are ignored
during the import function.

Mandatory Import Fields

There is an absolute minimal set of fields which must be imported in
order to properly process credit card transactions.  These fields are:

¥ CardOrAccount The credit card number.
¥ Expiration Expiration date.
¥ Amount Dollar amount of credit card transaction.
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CardOrAccount
A  text field maximum of 24 characters (which exceeds the maximum
length of any correct credit card number).  The credit card number may
be unformatted or formatted w ith blanks. Example:

5146287567783904
5146 2875 6778 3904

Expiration
The credit card expiration date is a five-character field consisting of the
two-character month followed by a slash and the two-character year. 

Note:  the year 2000 (00) is properly handled. Examples:
11/ 99
02/ 97
01/ 00

Note:  Transactions which do not have an expiration date can be
imported and processed.  However, this is not recommended by many
services. 

Amount
The transaction Amount is a maximum of eight (8) characters.  The
Amount is formatted as a simple decimal number w ith two digits to the
right of the decimal point and no comma in the thousands position.
Examples:

25000. 00
1. 00
10. 02

Address Verification

CN!Express can transmit bil ling addresses which are then checked for
accuracy by the processor.  Frequently, these are also called the card
holderÊaddresses. 

Address verification is available only for US bill-to addresses and only for
MasterCard, Visa, Discover, and American Express.  (Consult your
individual processor to see which cards are supported.)

For AVS purposes, only the Zip and Street address are required.  The City
and State information is not transmitted to the processing center.
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Bill Zip
This field may contain either a five (5) digit US Zip Code or the extended
nine (9) digit US Zip+4 code.  To be properly recognized, the US Zip
Code must be exactly  5 or 9 digits.  Do not use a hyphen between the Zip
and the +4 codes. 

Non-US postal codes which are nine (9) or fewer digits may be imported
in this field, but are ignored. 

Bill Address1
This field contains the street (or Post Office Box) address at which the
customer receives their credit card bill ing statement. Maximum of 20
characters. Examples:
 PO Box 458

145 Gr ove St .
132 E For d Dr .

Merchant and Configuration Information

In addition to the above fields, CN!Express must transmit certain
merchant and site configuration information to the processor.  For
example, when processing w ith Paymentech/ Gensar, the following
information is transmitted:

¥ Merchant Number
¥ Client Number
¥ Terminal Number

These values w ill be provided to you by your processor.

When operating a simple configuration w ith only one merchant and a
single Terminal Number, CN!ExpressÊwill use the default values defined
in your Configuration settings.  However, CN!ExpressÊcan import all
three of these fields which allows you to support multiple terminals,
clients, and merchants.
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Actions/Transaction Types

CN!Express  supports the following transaction types. The initial
character is used to represent the type of transaction during Imports. 
Transactions:

¥ A-Authorize Only.
¥ I-Incremental  Authorizations.
¥ C-Credit Sale
¥ P-Partial Reversal
¥ D-Deposit
¥ R-Refund
¥ V-Void

A-Authorize Only
Used for credit cards.  Receive an authorization code.  Perform Address
Verification if available.  Transaction w ill need to be deposited at a later time.

I-Incremental Authorization
This action is provided for future capabilities. Incremental Authorization
is currently not supported for the Direct Marketing industry.

C-Credit Sale
This action is sometimes referred to as Conditional Deposit. The
transaction w ill first be Authorized.  If the Authorization succeeds, the
transaction w ill then be automatically deposited.  You need take no
further action after receiving a successful Authorization code.

P-Partial Reversal
The PS-2000 specification requires that once you obtain an authorization
code for a specific amount that you deposit that same amount.  If you
must deposit a smaller amount (perhaps because something was not in
stock), you must issue a Partial Reversal  against the authorization.  This
transaction is only available for Visa card transactions.

D-Deposit
Deposit requires that you have previously received an Authorization code. 

R-Refund
Refund the amount in the Amount field to the customer�s card.  The
dollar amount should be a positive number. 
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V-Void
If, during the course of a single day, you discover that a transaction
which you have submitted for Credit Sale, Deposit, or Refund is
erroneous, you can mark the transaction as Void. 
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Appendix C - Purchasing Cards

Overview

CN!ExpressÊsupports the additional information which is required to be
transmitted w ith Purchasing Cards.

Purchasing cards require the following fields:
¥ CardOrAccount
¥ Expiration
¥ Amount
¥ BillZip
¥ ShipZip
¥ CustomerReference
¥ SupplierReference
¥ Tax

ShipZip
Purchase cards require you provide both the customers Bil ling Zip and
the Zip to which the product is being shipped.

CustomerReference
This is a 17-character field consisting of a Customer ID number or a
Customer Purchase Order number.

SupplierReference
A  9 character value containing an Order or Invoice number.  This field is
only required for American Express transactions.

Tax
Amount of tax contained in the sale.
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Appendix D - Paymentech/Gensar
Specifics

Overview

CN!Express supports Paymentech�s (formerly Gensar�s) Host mode.
When setting up your account w ith Paymentech, specify either that you
will be using the Host mode or that you w ill be using CN!Express.
CN!ExpressÊis certified with Paymentech and they will set you up
accordingly. 

Configuration Numbers

You will receive the following numbers from Paymentech:
¥ A  Client ID.
¥ A  Terminal ID.
¥ One or more Merchant IDs.

Supported Transaction Types

CN!ExpressÊsupports the following transaction types when
communicating w ith Paymentech. 

¥ A-Authorize Only.
¥ C-Credit Sale (Performs Auth and Deposit in same transaction.)
¥ P-Partial Reversal (Visa Only)
¥ D-Deposit
¥ R-Refund
¥ V-Void

Special Processing

CN!ExpressÊsupports the following special processing methods when
communicating w ith Paymentech.
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Paymentech/ Gensar Specifics Appendices

Address Verification
If you provide a Bill Zip Code and (optionally) a Bill Address, Address
Verification w ill automatically be performed.  Address Verification is
available only for US addresses.

Purchase Cards
CN!ExpressÊsupports the additional information required for processing
purchase cards.  See the Purchasing Cards appendix for additional
information as to which fields are required.

Settle Batches
Paymentech can configure your account to automatically close (settle)
batches at 5:30 AM  Eastern Standard Time.  This convenience allows you
to not worry about manually closing your batches at the end of the day.

If you do not want to use this automated feature, you w ill need to send
the “ X” transaction and the Batch ID to settle the batch.
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Appendix E - Paymentech/Gensar Errors

Overview

Error messages and codes returned from CN!ExpressÊare specific to the
particular merchant processing system.  The following are common error
messages from the Paymentech/ Gensar system.  Please contact your
processor for help with specific error-codes, or regarding error codes not
listed in this table.

Text                      Code       Meani ng                                                         
I nval i d Ter m I D 105 Mer chant  I D on a Bat ch I nqui r y or  Rel ease i s 

i ncor r ect .
Ter m Not  Act i ve 106 Pr ocessor  has not  act i vat ed t hi s t er mi nal  I D.
Aut h Decl i ned 200 Car dhol der ' s bank di d not  appr ove t r ansact i on.
Cal l  Voi ce Oper 201 Aut hor i zer  needs mor e i nf or mat i on f or  appr oval .
Hol d -  Cal l 202 Car d i ssuer  does not  want  car d used.  Cal l  f or  

f ur t her
i nst r uct i ons.
Cal l  Voi ce Oper 203 Aut hor i zer  di d not  r espond wi t hi n al l ot t ed t i me.
I nval i d Car d No 204 Account  number  i s i nval i d.
I nval i d Exp Dat e 205 Expi r at i on dat e i s ei t her  i ncor r ect  f or mat  or  

pr i or  t o
t oday.
I nval i d I CA No 206 I nval i d I nt er nat i onal  Cont r ol  Account  number .
I nval i d ABA No 207 I nval i d Amer i can Banki ng Associ at i on number .
I nval i d Bank MI D 209 The Bank Mer chant  I D i s i ncor r ect .
I nval i d Ter m No 210 The mer chant  I D i s not  val i d or  act i ve.
I nval i d Amount 211 Amount  i s pr obabl y 0.
Cal l  Voi ce Oper 214 Aut hor i zat i on cent er  cannot  be r eached.
Lost / St ol en Car d 215 Car d has been r epor t ed l ost  or  st ol en.
Over  Cr edi t  Fl r 217 Amount  r equest ed exceeds cr edi t  l i mi t .
Request  Deni ed 218 Tr ansact i on i s not  val i d f or  t hi s aut hor i zer .
Not  Onl i ne t o XX 220 Fat al  communi cat i ons er r or .
Aut h Decl i ned 224 Car d i s on pr i vat e l abel  negat i ve f i l e.
Car d Not  Al l owed 225 Mer chant  does not  accept  t hi s car d.
PL Set up Reqd 226 Mer chant  not  set  up f or  Pr i vat e Label .
BI N Not  Al l owed 227 Mer chant  cannot  accept  t hi s Pr i vat e Label  

BI N r ange.
Car d Not  Al l owed 228 Mer chant  cannot  accept  t hi s car d.
I nv Mer c Rst r ct  Code 229 Rest r i ct i on code f i el d cont ai ns i nval i d dat a.
Aut h Decl i ned 232 I nval i d car d t ype f or  Pr i or  Aut h sal e.
Aut h Decl i ned 233 Ter mi nal  Type not  suppor t ed.
* Request  Deni ed* 235 At t empt ed deposi t  wi t hout  val i d Aut h code.
Aut h Down- Ret r y 292 Aut hor i zer  i s not  r espondi ng.
Aut h Busy- Ret r y 293 Aut hor i zer  not  avai l abl e at  t hi s t i me.
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Aut h Busy- Ret r y 294 Aut hor i zer  not  avai l abl e at  t hi s t i me.
Aut h Er r or  -  Ret r y 297 Aut hor i zer  not  avai l abl e at  t hi s t i me.
I nval i d Ter m I D 300 The l engt h of  t he mer chant  I D i s i ncor r ect  or  

cont ai ns
i nval i d dat a.
I nval i d Funct i on 301 Tr ansact i on code i s i ncor r ect .
I nval i d Exp Dat e 303 Car d has expi r ed.  Mont h not  01- 12.  year  not  00- 99.
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Text                      Code       Meani ng                                                         
Amt  Ent r y Er r or 305 Amount  l ess t han . 01,  gr eat er  t han 999999. 99,  or  

cont ai ns
non- di gi t s.
I nval i d Car d 307 I nval i d car d t ype or  account  number .
Aut h # Not  Ent er ed 308 Aut h code mi ssi ng on Deposi t ,  I ncr ement al  Aut h,  

or  Par t i al
Rever sal
I nv/ Mi ssi ng Ret r  Ref 320 Ret r i eval  Ref er ence # mi ssi ng or  cont ai ns al pha dat a.
I nv MO/ TO Number 324 Mai l / Tel ephone Or der  number  i s i nval i d.
Rever sal  Aut h Exi st s 340 A second r ever sal  aut h was at t empt ed.  Onl y one 

i s
per mi t t ed.
I nv Amount / Rever sal 341 Rever sal  amount  i s i nval i d or  gr eat er  t han 

or i gi nal
aut h amount .
I nval i d Ter m I D 400 Mer chant  I D not  f ound i n mer chant  f i l e.
I nval i d Ter m I D 401 Mer chant  I D not  f ound i n t er mi nal  f i l e.
Ter m Not  Act i ve 402 Pr ocessor s has not  act i vat ed t hi s t er mi nal  I D.
Too Many Bat ches 407 Ther e ar e 999 open bat ches f or  t hi s mer chant .
I nval i d Ter m I D 410 The Ter mi nal  I D por t i on of  t he mer chant  I D i s 

i ncor r ect .
I nval i d Funct i on 415 Mer chant  i s Aut hor i zat i on Onl y and dr af t  capt i on 

was
r equest ed.
Amount  Too Lar ge 420 Maxi mum sal e amount  exceeded.
Amount  Too Lar ge 421 Maxi mum r et ur n amount  exceeded.
Dscv Not  Al l owed 428 Mer chant  not  set  up f or  Di scover  t r ansact i ons.
Rev Not  Al l owed 429 The bat ch cont ai ni ng t he t r ansact i on t o voi d has 

been
r el eased.
Dscv Not  Al l owed 430 Mer chant  not  set  up f or  Di scover
DC Not  Al l owed 431 Mer chant  not  set  up f or  Di ner s Cl ub
CB Not  Al l owed 432 Mer chant  not  set  up f or  Car t e Bl anche.
I nval i d Key 433 No Amex subscr i ber  number .
Cl i ent  Not  Found 999 Cl i ent  i dent i f i er  f i el d i s not  on pr ocessor ' s 

syst em.
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